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INSTALLATION GUIDE

SCXI -1331 HIGH-VOLTAGE GENERAL-PURPOSE 
TERMINAL BLOCK

This guide describes how to use and install the SCXI-1331 terminal block 
with your SCXI-1127 module.

Introduction 
The SCXI-1331 terminal block consists of a shielded board with 84 screw 
terminals for easy connection to the SCXI-1127 input connector. The 
SCXI-1331 allows you to connect 1-, 2-, and 4-wire signals to the 
SCXI-1127. It also has terminals for connecting external trigger signals to 
the SCXI-1127. Detailed explanations of the various input and triggering 
terminals of the SCXI-1331 are in the SCXI-1127 User Manual.

Conventions Used in This Guide
The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options»Substitute 
Fonts directs you to pull down the File menu, select the Page Setup item, 
select Options, and finally select the Substitute Fonts options from the 
last dialog box.

This icon to the left of bold italicized text denotes a note, which alerts you 
to important information.

This icon to the left of bold italicized text denotes a caution, which advises 
you of precautions to take to avoid injury, data loss, or a system crash.

bold Bold text denotes the names of menus, menu items, parameters, dialog 
boxes, dialog box buttons or options, windows, or Windows 95 tabs.

bold italic Bold italic text denotes a note or caution.
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italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept.

monospace Text in this font denotes text or characters that you should literally enter 
from the keyboard and syntax examples. This font is also used for the 
proper names of functions, operations, variables, and filenames and 
extensions.

What You Need to Get Started
To set up and use your SCXI-1331 terminal block, you will need the 
following items:

❑ SCXI-1331 terminal block

❑ SCXI-1331 High-Voltage General-Purpose Terminal Block 
Installation Guide

❑ SCXI chassis

❑ SCXI-1127 module

❑ SCXI-1127 User Manual

❑ No. 1 and No. 2 Phillips-head screwdrivers

❑ 1/8 in. flathead screwdriver

❑ Long-nose pliers

❑ Wire cutter

❑ Wire insulation stripper

Safety Information
The following cautions contain important safety information concerning 
hazardous voltages.

Cautions You MUST insulate all of your signal connections appropriately to the HIGHEST 
available voltage with which the terminal block may come in contact. ANY voltage 
connected to the terminal block may appear on any other pin of this terminal 
block.

Equipment described in this document must be used in an Installation Category II 
environment per IEC 60664. This category requires local level mains-connected 
installation.

DO NOT OPERATE THE MODULE IN AN EXPLOSIVE ATMOSPHERE OR 
WHERE THERE MAY BE FLAMMABLE GASES OR FUMES.
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SHOCK HAZARD—This unit should only be opened by qualified personnel 
aware of the dangers involved. Disconnect all power before removing the cover. 
Always install the grounding screw. If signal wires are connected to the module or 
terminal block, dangerous voltages may exist even when the equipment is turned 
off. Before you remove any installed terminal block or module, disconnect the AC 
power line or any high-voltage sources, ((≥ ≥ 30 Vrms and 42.4 Vpeak, or 60 VDC), that 
may be connected to any terminal block or module.

DO NOT OPERATE DAMAGED EQUIPMENT. The safety-protection features 
built into this module can be impaired if the module becomes damaged in any way. 
If it is damaged, turn the module off and do not use it until service-trained 
personnel can check its safety. If necessary, return the module to National 
Instruments for service and repair to ensure that its safety is not compromised.

The terminal block must be used in a UL listed SCXI chassis with a UL listed 
SCXI module.

Use only 26-14 AWG wire with a voltage rating of 300 V and 60 °C for all signals 
that may come in contact with 250 V.

DO NOT SUBSTITUTE PARTS OR MODIFY EQUIPMENT. Because of the 
danger of introducing additional hazards, do not install unauthorized parts or 
modify the terminal block. Return the module to National Instruments for service 
and repair to ensure that its safety features are not compromised.

When using the terminal block with high common-mode voltages, you MUST 
insulate your signal wires appropriately. National Instruments is NOT liable for 
any damages or injuries resulting from inadequate signal wire insulation.

Connections, including power signals to ground and vice versa, that exceed any of 
the maximum signal ratings on the SCXI-1331 can damage any or all of the 
modules connected to the SCXI chassis, the host computer, and the SCXI-1331. 
National Instruments is NOT LIABLE FOR ANY DAMAGES OR INJURIES 
resulting from incorrect signal connections.

If high voltages ((≥ ≥ 30 Vrms and 42.4 Vpeak, or 60 VDC) are present, YOU MUST 
CONNECT SAFETY EARTH GROUND TO THE STRAIN-RELIEF TAB OF 
THE TERMINAL BLOCK. This maintains compliance with UL 3111-1 and 
IEC-61010, and protects against electric shock when the terminal block is not 
connected to the chassis. To connect the safety earth ground to the strain-relief 
tab, run an earth ground wire in the cable from the signal source to the terminal 
block. National Instruments is NOT liable for any damages or injuries resulting 
from inadequate safety earth ground connections.

Do not loosen or re-orient the safety ground solder lug hardware when connecting 
the safety ground wire; to do so reduces the safety isolation between the high 
voltage and safety ground.
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Temperature Sensor Output and Accuracy
The SCXI-1331 temperature sensor outputs 0.2 to 0.024 V from 0 to 50 °C 
and has an accuracy of ±0.5 °C over the 15 to 35 °C range and ±0.9 °C over 
the 0 to 15 °C and 35 to 50 °C ranges.1

National Instruments software can convert a thermistor voltage to the 
thermistor temperature for the circuit diagram shown in Figure 3 later in 
this guide. In LabVIEW, you can use the Convert Thermistor Reading 
virtual instrument (VI) in the Data Acquisition»Signal Conditioning 
palette. If you are using LabWindows/CVI or NI-DAQ, use the 
Thermistor_Convert  function. The VI takes the output voltage of the 
temperature sensor, the reference voltage (2.5 V), and the precision 
resistance (189 kΩ) and returns the thermistor temperature.

Alternatively, you can use the following formulas:

T(°C) = TK – 273.15

where TK is the temperature in Kelvin,

where a = 1.295361 × 10–3

b = 2.343159 × 10–4

c = 1.018703 × 10–7

RT = resistance of the thermistor in ohms,

where VTEMPOUT is the output voltage of the temperature sensor,

where T(°F) and T(°C) are the temperature readings in degrees Fahrenheit 
and degrees Celsius, respectively.

1   Includes the combined effects of the temperature sensor accuracy and the temperature difference between the temperature 
sensor and any screw terminal. The temperature sensor accuracy includes tolerances in all component values, the effects 
caused by temperature and loading, and self-heating.
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Signal Connection

Note Refer to the Safety Information section before removing equipment covers or 
connecting or disconnecting any signal wires.

To connect the signal to the terminal block, perform the following steps, 
referring to Figures 1 and 2 as necessary:

1. Unscrew the top cover screws and remove the cover.

2. Loosen the strain-relief screws and remove the strain-relief bar.

3. Run the signal wires through the strain-relief opening. You can add 
insulation or padding if necessary.

4. Prepare your signal wire by stripping the insulation no more than 
7 mm.

5. Connect the wires to the screw terminals by inserting the stripped end 
of the wire fully into the terminal. No bare wire should extend past the 
screw terminal. Exposed wire increases the risk of shorting and 
causing a failure.

When connecting your signals to the SCXI-1331, follow the labeling 
on the SCXI-1331 for the appropriate module, as indicated in Figure2.

6. Tighten the screws to a torque of 5–7 in.-lb.

7. Connect safety earth ground to the safety ground solder lug. Refer to 
the Safety Information section for connection information.

8. Reinstall the strain-relief bar and tighten the strain-relief screws.

9. Reinstall the top cover and tighten the top cover screws.

10. Connect the terminal block to the module front connector as explained 
in the Installation section later in this guide.
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Figure 1 shows the SCXI-1331 terminal block parts locator diagram.

Figure 1.  SCXI-1331 Parts Locator Diagram
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Figure 2 shows the SCXI-1331 signal connections.

Figure 2.  SCXI-1331 Signal Connections

Installation
To connect the terminal block to the SCXI module front connector, perform 
the following steps:

1. Connect the module front connector to its mating connector on the 
terminal block.

2. Tighten the top and bottom thumbscrews on the back of the terminal 
block to hold it securely in place.

Note For accurate cold-junction compensation, place the SCXI chassis away from an 
extreme temperature differential.
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Cleaning the Terminal Block
Clean the terminal block by brushing off light dust with a soft, nonmetallic 
brush. Remove other contaminants with deionized water and a stiff 
nonmetallic brush. The unit must be completely dry and free from 
contaminants before returning to service.

Temperature Sensor Circuit Diagram
The circuit diagram in Figure 3 is optional information that you can use if 
you want more details about the SCXI-1331 temperature sensor.

Figure 3.  Temperature Sensor Circuit Diagram
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Specifications
All specifications are typical at 25 °C unless otherwise specified.

Cold-Junction Sensor
Accuracy1............................................... 0.5 °C from 15 to 35 °C 

0.9 °C from 0 to 15 °C and 
35 to 50 °C

Output..................................................... 0.2 to 0.024 V from 0 to 50 °C

Maximum Voltage 
Terminal to earth.................................... 250 Vrms or VDC

Terminal to terminal............................... 250 Vrms or VDC

Environment
Operating temperature............................ 0 to 50 °C

Storage temperature ............................... –20 to 70 °C

Relative humidity................................... 10 to 90%

Safety
Designed in accordance with IEC61010-1, UL 3111-1, and 
CAN/CSA C22.2 No. 1010.1 for electrical measuring and test equipment

Approved at altitudes up to 2000 m

Indoor use only

Installation Category II

Pollution Degree 2

1   The temperature sensor accuracy includes tolerances in all component values, effects caused by temperature, loading, 
self-heating, and temperature gradients.



SCXI-1331 Installation Guide 10 © National Instruments Corporation

Support Information

Internet Support
E-mail: support@natinst.com
FTP Site: ftp.natinst.com
Web Address: http://www.natinst.com

Bulletin Board Support
BBS United States: 512 794 5422
BBS United Kingdom: 01635 551422
BBS France: 01 48 65 15 59

Fax-on-Demand Support
512 418 1111

Telephone Support (USA)
Tel: 512 795 8248
Fax: 512 794 5678

International Offices
Australia 03 9879 5166, Austria 0662 45 79 90 0, Belgium 02 757 00 20, Brazil 011 288 3336, 
Canada (Ontario) 905 785 0085, Canada (Québec) 514 694 8521, Denmark 45 76 26 00, Finland 09 725 725 11, 
France 01 48 14 24 24, Germany 089 741 31 30, Hong Kong 2645 3186, Israel 03 6120092, Italy 02 413091, 
Japan 03 5472 2970, Korea 02 596 7456, Mexico 5 520 2635, Netherlands 0348 433466, Norway 32 84 84 00, 
Singapore 2265886, Spain 91 640 0085, Sweden 08 730 49 70, Switzerland 056 200 51 51, Taiwan 02 377 1200, 
United Kingdom 01635 523545

National Instruments Corporate Headquarters
6504 Bridge Point Parkway Austin, Texas 78730-5039 USA Tel: 512 794 0100
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